Adobe® Marketing Cloud
Ad Hoc Analysis
Contents

Ad Hoc Analysis Help ..............................................................................................................................7

Getting Started ........................................................................................................................................8
    System Recommendations ......................................................................................................................8
    Launch Ad Hoc Analysis ......................................................................................................................9
        Log In from the Marketing Cloud ..................................................................................................9
    Projects and Workspaces ....................................................................................................................10
        Start a Project ...............................................................................................................................10
        Open a Recently Saved Workspace ...........................................................................................10
        Share Projects ...........................................................................................................................11
        Rename a workspace ..................................................................................................................11
        Open Local Project ....................................................................................................................11
    Report Templates ...............................................................................................................................11
        Open a Report ............................................................................................................................12

Administration .........................................................................................................................................13
    User Licenses ......................................................................................................................................13
        Grant User Licenses ....................................................................................................................13
        Manage User Sessions ................................................................................................................13
    Permissions .........................................................................................................................................14
        Add a User to the All Report Access Group .............................................................................14
        Create Permission Groups .........................................................................................................14
    Set Up Proxy Policies in Java ............................................................................................................14
    How Data is Sampled .........................................................................................................................14

Calculated Metric Builder .....................................................................................................................16

Configure Existing Reports ...................................................................................................................17
    Report Actions ...................................................................................................................................17
    Chart Options ....................................................................................................................................17
Bubble Chart ......................................................................................................................... 18
Break Down Table Data .......................................................................................................... 18
Change the Report Type in the Table ..................................................................................... 19
Copy Data to the Clipboard .................................................................................................... 19
Extract Visitor IDs .................................................................................................................. 19
Trend a Row ............................................................................................................................ 20
Set Column Width ................................................................................................................... 20

Dates and Date Ranges ......................................................................................................... 21
  Legacy Date Slices ............................................................................................................... 21

Dimensions .................................................................................................................................. 23

Group Manager ....................................................................................................................... 24

Log File .................................................................................................................................... 25

Metrics ............................................................................................................................................ 26
  Add Metrics to a Report ........................................................................................................ 26
  Organize Metrics ................................................................................................................... 26

Reports ......................................................................................................................................... 28
  Reports Overview .................................................................................................................. 28
  Statistical Calculations ......................................................................................................... 28
  Statistical Calculation Overlays .......................................................................................... 30
  Report Types ........................................................................................................................ 30
  Ranked Reports ..................................................................................................................... 30
  Trended Reports .................................................................................................................... 30
  Totals Report ......................................................................................................................... 31
  Flow Reports ......................................................................................................................... 31
  Conversion Funnel Reports ................................................................................................... 33
  Site Analysis Report ............................................................................................................. 33
  Site Metrics Reports ............................................................................................................. 34
  Page Views Report ............................................................................................................... 34
<table>
<thead>
<tr>
<th>Mobile Reports</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Devices Report</td>
<td>38</td>
</tr>
<tr>
<td>Manufacturer Report</td>
<td>38</td>
</tr>
<tr>
<td>Screen Size Report</td>
<td>38</td>
</tr>
<tr>
<td>Screen Height Report</td>
<td>38</td>
</tr>
<tr>
<td>Screen Width Report</td>
<td>38</td>
</tr>
<tr>
<td>Cookie Support Report</td>
<td>38</td>
</tr>
<tr>
<td>Image Support Report</td>
<td>38</td>
</tr>
<tr>
<td>Color Depth Report</td>
<td>39</td>
</tr>
<tr>
<td>Audio Support Report</td>
<td>39</td>
</tr>
<tr>
<td>Video Support Reports</td>
<td>39</td>
</tr>
<tr>
<td>DRM Report</td>
<td>39</td>
</tr>
<tr>
<td>Net Protocols Report</td>
<td>39</td>
</tr>
<tr>
<td>Operating System Report</td>
<td>39</td>
</tr>
<tr>
<td>Java Version Report</td>
<td>39</td>
</tr>
<tr>
<td>Bookmark URL Length Report</td>
<td>39</td>
</tr>
<tr>
<td>Mail URL Length Report</td>
<td>40</td>
</tr>
<tr>
<td>Browser URL Length Report</td>
<td>40</td>
</tr>
<tr>
<td>Device Number Transit Report</td>
<td>40</td>
</tr>
<tr>
<td>PTT Report</td>
<td>40</td>
</tr>
<tr>
<td>Decoration Mail Support Report</td>
<td>40</td>
</tr>
<tr>
<td>Information Services Report</td>
<td>40</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paths Reports</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fallout Report</td>
<td>41</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Traffic Sources Reports</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Keywords</td>
<td>43</td>
</tr>
</tbody>
</table>
Search Engines ......................................................................................................................... 43
Referring Domains ...................................................................................................................... 44
Original Referring Domains ................................................................................................. 44
Referrers ...................................................................................................................................... 44
Referrer Type .......................................................................................................................... 44
Campaigns .................................................................................................................................. 45
Products ........................................................................................................................................ 45
Products Conversion Funnel .................................................................................................... 45
Products ........................................................................................................................................ 45
Categories ............................................................................................................................... 46
Visitor Retention .................................................................................................................... 46
Return Frequency .................................................................................................................. 46
Visit Number .......................................................................................................................... 46
Customer Loyalty ................................................................................................................... 47
Visitor Profile .......................................................................................................................... 47
GeoSegmentation ................................................................................................................... 48
Conversion Reports .............................................................................................................. 48
Custom ....................................................................................................................................... 48
Adobe Target ........................................................................................................................... 48
Marketing Channel Reports .................................................................................................. 49

Building Segments .................................................................................................................. 50

Settings ......................................................................................................................................... 53
General Settings Tab - Definitions .......................................................................................... 53
Ranked Tab - Definitions ......................................................................................................... 54
Site Analysis Tab - Definitions ................................................................................................ 54
Font and Locale Tab - Definitions .......................................................................................... 55

Scheduling Manager .................................................................................................................. 56
Schedule a report for delivery .................................................................................................. 56
Delivery Options - Definitions ................................................................................................. 56
Advanced Format Settings - Definitions .................................................................................. 57
Ad Hoc Analysis Help

Ad Hoc Analysis helps you identify high-value customer segments with unlimited real-time visitor information, allowing you to drill down into the data to get deep, precise, and comprehensive views of your customers.

Information resources for Ad Hoc Analysis and the Adobe Marketing Cloud are listed below:

**Important:** As of May 2018, Ad Hoc Analysis will support only Java 8 or higher. If you choose to run Ad Hoc Analysis on Java 7 after the May 2018 Maintenance Release, Adobe will no longer support your Ad Hoc Analysis implementation. Our .jar files are signed with a secure 256-bit encryption that is not supported by Java versions less than 1.7.0_76. This 256-bit certificate allows us to serve you with enhanced security.

- Check out the section on Ad Hoc Analysis vs. Analysis Workspace: Analysis Workspace brings much of the Ad Hoc Analysis functionality into the browser workflow. While some terminology and features remain the same between the products, there are some new terms and approaches to analysis that are introduced in Analysis Workspace.
- **Getting Started**
  
  Get help on logging in, running a report, and editing a user's account.

- **Administration**
  
  Configure users and learn about data sampling.

**New and Popular Topics**

**Marketing Cloud Resources**

- Adobe Analytics Community
- Marketing Cloud Release Notes
- Product Documentation Home
- Developer
- Idea Exchange
- Adobe Training and Tutorials
- Featured Solutions Center
## Getting Started

You can perform instantaneous, advanced analysis on website activity. You can view multiple reports simultaneously and apply segments across multiple dimensions. You can analyze the data from both micro and macro perspectives to view their impact on your important business metrics.

These features enable you to answer questions about site traffic, visitor demographics, revenue, and product movement. You can then filter, sort, and segment your data to find the answers to precise questions. The results are returned almost instantaneously, enabling you to quickly analyze the effects of a combination of factors.

### Getting Started Tasks

<table>
<thead>
<tr>
<th>Getting Started Tasks</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Log in to Adobe Analytics.</td>
<td>Go to sc.omniture.com and log in using your Adobe Analytics credentials. You can also log in from the Marketing Cloud page by selecting the login link.</td>
</tr>
<tr>
<td>2. Launch Ad Hoc Analysis.</td>
<td>Click Adobe Analytics &gt; Tools &gt; Ad Hoc Analysis, and then click the Launch Ad Hoc Analysis button.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you do not see the Launch Ad Hoc Analysis button on this page, make sure the administrator added you to the Ad Hoc Analysis License User group in the Admin Tools.</td>
</tr>
<tr>
<td>3. Create a project.</td>
<td>On the start-up page, select a report suite, then click Create Project. See Projects and Workspaces.</td>
</tr>
</tbody>
</table>
| 4. Open a report.                      | Search for a report using the standard Cloud report menu. You can also choose a template.  
                                        | See Report Templates.                                                                                                                      |
| 5. Configure the report.               | Configure reports by performing tasks, such as:                                                                                           |
|                                        | • Create segments to dig deeper into data                                                                                                 |
|                                        | • Adding metrics, dimensions, and segments to the Table Builder                                                                            |
|                                        | • Configuring date ranges                                                                                                                  |
|                                        | • Scheduling report delivery                                                                                                               |
|                                        | Search this help system to locate the help you need.                                                                                       |

### System Recommendations

Though reports should function appropriately with most popular Web browsers, reports look and function best on systems that meet certain recommendations.

**Note:** As of May 2018, Ad Hoc Analysis will support only Java 8 or higher. If you choose to run Ad Hoc Analysis on Java 7 after the May 2018 Maintenance Release, Adobe will no longer support your Ad Hoc Analysis implementation.

- Video card supporting OpenGL 2.0
• Cookies: Required
• Operating System: Windows and Mac OS.
• Macromedia Flash Player: version 6 or later
• Monitor Resolution: 800x600 (1024x768 recommended)
• Color Depth: 16-bit or greater
• JavaScript: Enabled
• Java version: Java 1.7 or later (See Note above)

If you do not have the correct version of Java installed, it is installed for you. If you have a non-compatible version of Java installed, Ad Hoc Analysis downloads and prompts you to install the updates.

Java Upgrade Instructions
As of May 2018, Ad Hoc Analysis will support only Java 8 or higher. If you choose to run Ad Hoc Analysis on Java 7 after the May 2018 Maintenance Release, Adobe will no longer support your Ad Hoc Analysis implementation.

Our .jar files are signed with a secure 256-bit encryption that is not supported by Java versions less than 1.7.0_76. This 256-bit certificate allows us to serve you with enhanced security.

If you still have Java 7 installed, you must upgrade before the May 2018 Maintenance release. Here's how:

• If you are allowed to install programs on your machine:
  2. Click Free Java Download.
  3. Click Agree and Start Free Download.
  4. Install the latest Java version specific to your Operating System.

• If you are not allowed to install programs on your machine:
  1. Work with your IT department to get the latest version of Java installed.

Launch Ad Hoc Analysis
You can log in from the Marketing Cloud or from a URL. If you log in from Reports and Analytics, you are automatically logged in. Logging in using a URL is necessary only if you access the ad hoc analysis URL from another location, such as a link or from a favorites menu.

Log In from the Marketing Cloud
Steps that describe how to log in from the Marketing Cloud.

1. In a browser, navigate to www.sc.omniture.com.
2. Type your company name, your username, and your password. Then click Sign In.
3. Click Adobe Analytics > Tools > Ad Hoc Analysis.
   If you do not see the Launch Ad Hoc Analysis button on this page, make sure the administrator added you to the Ad Hoc Analysis License User group in the Admin Tools.
4. Click Launch Ad Hoc Analysis.
5. Save the discover.jnlp file locally.
   You can run this saved file whenever you want to launch Ad Hoc Analysis.
Projects and Workspaces

A project defines the set of data that is imported, including a report suite and a date range. A project consists of any number of reports with all of their metrics, settings, dimensions, and segments. You can begin a new project, load a saved project, or load the project that automatically saves.

You group reports into a workspace. A project can contain multiple workspaces, and a workspace can contain multiple reports. The relationship among these items is best understood as a nested one:

You can open only one project at a time. However, you can open multiple workspaces in a project. In each workspace you can have several reports open.

The default date range for a new project is Last 90 Days.

Start a Project

Steps that describe how to start a project.

1. Log in.
2. Open a saved project or click Create Project.
3. Search for a report, or choose a template.

Open a Recently Saved Workspace

Steps that describe how to open recently saved workspaces.

Click File > Recent Workspace.

You can open up to five recent workspaces. Recent workspaces are not available after exiting your session.
**Share Projects**

Shared projects will be available to all Ad Hoc Analysis users in the company.

1. Go to **File > Save As**.
2. Select **Shared Projects** from the **Save in:** drop-down.
3. Click **Save** to save the project.

   Shared projects can be opened via **File > Open > Shared Projects**.

   **Note:** You can delete your own shared projects in the same dialog box for sharing projects by selecting one or more projects.

**Rename a workspace**

Steps that describe how to rename a workspace.

1. Right click the workspace name.
2. Choose **Rename Workspace**.
3. Type a name, then click **OK**.

**Open Local Project**

Steps that describe how to open a local copy of a project.

1. Click **File > Open Local Copy**.
2. Navigate to the local .dproj file, then click **Open**.

**Report Templates**

Templates are starting points for the type of analysis you want to perform. A template can be a blank canvas, such as a Ranked or Fallout report. Or, the template is a report that starts with default metrics and dimensions.

You can access templates when creating a project (**File > New Project**), or by adding a workspace or report.

<table>
<thead>
<tr>
<th>Types of Templates</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ranked</td>
<td>Provides a blank canvas where you can construct a table. For example, a <strong>Pages</strong> report ranks the pages on your site based on traffic. The detail table shows percentages and numbers for metrics like Page Views and Revenue.</td>
</tr>
<tr>
<td>Tended</td>
<td>Lets you examine how conversions and events trend over a selected time granularity (Hour, Day, Week, Month, Quarter, or Year) during a reporting period.</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Totals</td>
<td>An executive-level report that shows bottom-line figures. It contains data for Total Revenue, Page Views, and Orders.</td>
</tr>
<tr>
<td>Fallout</td>
<td>Lets you construct a funnel that displays conversion and fallout rates between checkpoints. For example, you can track a visitor’s fallout points during a buying process.</td>
</tr>
<tr>
<td>Flow</td>
<td>Shows the most common paths users take across pages, site sections, and servers.</td>
</tr>
<tr>
<td>Conversion Funnel</td>
<td>Shows conversion percentages between specific metric events. You can use this report to understand the number of click-throughs that generate sales, and the number of units sold.</td>
</tr>
<tr>
<td>Site Analysis</td>
<td>A three-dimensional site pathing tool that displays how visitors move through specified pages and events.</td>
</tr>
<tr>
<td>Virtual Focus Group</td>
<td>Takes a visit at random from your visits and shows you an extensive amount of data about the visit. You can use the report to create focus groups from your visitor population.</td>
</tr>
</tbody>
</table>

**Open a Report**

You can open a report or a template when you create a project, or from within an existing project. Use a template to configure a report from scratch.

Several ways are available to open a report:

- On the **New Report** page, search for a report or choose a template.
- Click **Reports** from the menu, then select a report or report template.
- Launch a report from a dimension: right-click a dimension name, then select **Run Report > report name**.
Administration

Configure users and learn about data sampling.
For Admin Console help, see the Analytics Reference.

User Licenses

Before a user can log in, the user must be granted a user license. User licenses are concurrent-use licenses. Users can share user licenses, but the number of users at any given time is limited to the number of user licenses purchased.

When the number of logged-in users exceeds the number of available licenses, a dialog box notifies the user that all available licenses are in use. The user's position in the queue is shown along with a link to recheck the queue position. When a license becomes available, the user is notified with an email and a pop-up dialog box indicating that ad hoc analysis is available for access. The user then has 15 minutes to respond before losing the position in the queue.

Grant User Licenses

Steps that describe how local Reports and Analytics administrators can grant user licenses via the permissions system.

1. Log in to the Marketing Cloud.
2. Click Admin > User Management.
3. Click Edit Groups.
   If your company has purchased user licenses, the Ad Hoc Analysis License Users group appears in the Group Name column. The number of available licenses for user logins is also shown.
4. Click Edit.
5. Under Assign User Logins, select the users you want to add to the group, then click Add.
6. Click Save Group.
   The licensing system does not limit the number of users that are added to a group. There is limited concurrent usage to the number of user licenses purchased.

Manage User Sessions

Steps that describe how an administrator can terminate a user's session. This feature does not prevent a terminated user from logging in again.

1. In marketing reports and analytics, click Adobe Analytics > Admin > User Management, then click Manage Users.
2. Locate the user, then click Terminate.
   On the Active Ad Hoc Analysis Sessions page, the user who has been idle the longest displays at the top of list.
Permissions

You set up access to report suites in the Administration Console. You can configure permission at the report suite level. For example, if you have multiple report suites enabled, but you do not want to grant all users access to all report suites, you can create groups with specific report suites, and then assign those users to the applicable group.

Add a User to the All Report Access Group

Steps that describe how to grant non-admin users access to all report suites.

1. Log in to the Marketing Cloud.
2. Click Adobe Analytics > Admin > User Management > Edit Groups.
3. Click All Report Access.
4. In Available Users, select the user, then click Add.
5. Click Save Group.

Create Permission Groups

Create permission groups for non-admin users for specific report suites.

1. Log in to the Marketing Cloud.
2. Click Adobe Analytics > Admin > User Management > Edit Groups.
3. Create a permissions group for non-admin users that includes the ad hoc analysis-activated report suites that you want accessible to users.

   The report suites available to the user are displayed in the Report Cloud menu when you create a new project.

Set Up Proxy Policies in Java

Steps that describe how to set up proxy policies if you receive a server connection error.

Ad Hoc Analysis uses HTTP to communicate with the server. It is subject to the same proxy policies as other HTTP traffic.

1. In the Windows Control Panel, launch the Java Control Panel.
2. On the General tab, click Network Settings.
3. Select Use browser settings, or manually configure the proxy settings.
4. Click OK, then click OK on the Java Control Panel.

How Data is Sampled

Samples of visitor data is taken to produce meaningful, accurate reporting. The date range is used as the data slice for a loaded project. A slice typically represents the current month, plus the previous two months.

For optimal processing, ad hoc analysis uses roughly 750 million as the maximum hits per slice. (Hits = page views + events.)

To arrive at the projected sample rate, the projected hits are calculated per data set, then divided by 750 million, as shown here:
• (Avg. daily hits x number of days in the slice) / 750 million

For example, if you have 10 million hits a day, with a data slice of 90 days:
• (10,000,000 x 90) / 750,000,000 = 1.2

So to keep the number of hits for this 90 day slice below 750,000,000, the data could be sampled at 1.2:1, but because samples on whole numbers are used, the sample rate is 2:1.

As another example, if you have 10 million hits a day, with a data slice for 365 days:
• (10,000,000 x 365) / 750,000,000 = 4.8

So to keep the number of hits for this 365 day slice below 750,000,000, the data could be sampled at 4.8:1. Using whole numbers, the sample rate is 5:1.
Calculated Metric Builder

The Calculated Metric Builder in Ad Hoc Analysis is now tied in with Analytics Unified Calculated Metrics. Its user interface is similar to the Calculated Metric Builder in Analytics.

For more information on how Calculated Metrics are built and managed, see the Calculated Metric Guide.

Here is how you access the Calculated Metric Builder in Ad Hoc Analysis:

1. In the Metrics pane, click More Options, then Calculated Metrics Builder.

2. The Calculated Metric Builder interface lets you drag and drop metrics, segments, and functions to build your custom metrics:
Configure Existing Reports

Learn about the various actions you can perform on a report, such as configuring charts, graphs, breakdowns, and extracting data.

Report Actions

Actions that you can perform on a report, such as copying, saving, printing, renaming, and configuring delivery options.

In a report, click the Report Actions drop-down.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset Report Positions</td>
<td>Resets reports to their original positions after moving (dragging) them within a workspace.</td>
</tr>
<tr>
<td>Copy or Move Report</td>
<td>Lets you copy or move a report to a new workspace.</td>
</tr>
<tr>
<td>Copy Report Data</td>
<td>Lets you copy report data for pasting into external applications like Excel.</td>
</tr>
<tr>
<td>Save Chart As</td>
<td>Lets you save a chart as a .jpg or .png file.</td>
</tr>
<tr>
<td>Delivery Options</td>
<td>See Delivery Options - Definitions.</td>
</tr>
<tr>
<td>Print</td>
<td>Lets you print the report.</td>
</tr>
<tr>
<td>Rename Report</td>
<td>Renames the report tab.</td>
</tr>
<tr>
<td>Data Sources</td>
<td>See General Settings Tab - Definitions.</td>
</tr>
<tr>
<td>View</td>
<td>Specifies whether to view the chart, graph, or both.</td>
</tr>
</tbody>
</table>

Chart Options

Options you can configure on a chart, such as changing the graph type, colors, and number of lines. Chart options differ depending on the type of graph you select.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph Type</td>
<td>Lets you change the graph type to a line graph, bar chart, stacked area graph, bubble, and so on.</td>
</tr>
<tr>
<td></td>
<td>• Bubble: The bubble chart is available for any ranked report. Bubble charts offer metrics analysis for up to five separate dimensions. You can use this chart as a scatter graph.</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>------------</td>
<td>----------------</td>
</tr>
<tr>
<td>plot when no metric is applied to the diameter of the points. The bubble chart dynamically changes to reflect changes in the report data.</td>
<td></td>
</tr>
<tr>
<td>Chart by</td>
<td>Lets you display values or percent values in the graph.</td>
</tr>
<tr>
<td>Number of Lines (Bars, Bubbles, and so on)</td>
<td>Specifies the number of table items or data points to display in the chart.</td>
</tr>
<tr>
<td>Colors</td>
<td>Lets you choose a color for each chart item.</td>
</tr>
<tr>
<td>X-Axis</td>
<td>Moves graphed items to the X axis.</td>
</tr>
<tr>
<td>Z-Axis</td>
<td>Moves graphed items to the Z axis</td>
</tr>
<tr>
<td>Y-Axis</td>
<td>Moves graphed items to the Y axis.</td>
</tr>
<tr>
<td>Show Linear Regression</td>
<td>For bubble charts. Displays a statistical approximation of your data.</td>
</tr>
</tbody>
</table>

**Bubble Chart**

Bubble charts offer metrics analysis for up to five separate dimensions. The bubble chart dynamically changes to reflect changes in the report data. The bubble chart is available for any ranked report.

<table>
<thead>
<tr>
<th><strong>Element</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>Specifies the reporting dimension.</td>
</tr>
<tr>
<td>Data Points</td>
<td>Specifies the number of data points to display in the bubble chart.</td>
</tr>
<tr>
<td>Show Linear Regression</td>
<td>Displays a statistical approximation of your data.</td>
</tr>
</tbody>
</table>

**Break Down Table Data**

Steps that describe how to break down table data.

Certain reports let you break down the table data so that you can see subrelated data in the report. You can break down any dimension by any other dimension item, report, segment, and so on.

**To break down table data**

1. Run a report.
2. Right-click a line item, then click Breakdown > item.
Note: For more flexibility, use the Table Builder to configure a report with breakdowns. After you open a saved or scheduled report with breakdowns, you might need to click Replace Table to refresh a breakdown of dynamic report data. For example, you might need to refresh a scheduled report containing breakdowns of line items that can change based on the date range or visitor activity.

Change the Report Type in the Table

Steps that describe how to change the report type (Select Report) from the detail table column.

For ranked reports, you can change the report to a different type of report while preserving the segments, metrics, and comparisons that you set up in the original report. This change expedites the process of gathering data, because there is no need to segment and configure successive reports.

To change the report type in the table

1. Open and configure a ranked report.
2. Right-click the report name column heading in the table, then click Select Report, then navigate to the report.

Copy Data to the Clipboard

Steps that describe how to copy report data to an Excel spreadsheet.

1. Open Excel.
   - It is recommended that you open Excel prior to copying data, because Excel clears the memory buffer when it starts.
2. At the report level, click Settings, then click Copy Report Data.
3. In Excel, select a cell, then paste the data.

Extract Visitor IDs

Steps that describe how to extract visitor IDs.

In marketing reports and analytics, you can set a field to contain user ID data. If you configured this option, the Extract Visitor IDs option becomes available. If you do not enable this option, but you decide to enable it later, you cannot go back and extract historical visitor IDs.

To extract visitor IDs

1. Add a data warehouse segment to the report.
2. Right-click the segment and select Extract Visitor IDs.
   - The data warehouse application launches.
3. On the Data Warehouse Request tab, type the filter name.
4. Click Request this Report.
Trend a Row

Steps that describe how to trend a row and launch a trended report from the table.

When viewing a ranked report, such as a products report, you can see the trend data for a value. For example, you can see that a product made $10,000 in gross revenue for the selected time period. If you want to see how much revenue that product generated for each day of the time period, you can show a trend graph for the product, or open a separate trended report.

To trend a row
1. Run a ranked report.
2. Click the Trend icon.
   You can select multiple cells to apply to a single trend report.

Set Column Width

Steps that describe how to set the width of one or more columns.

1. In the table, right-click the column header, then click Column Width.
   This option is disabled if Fit to Screen is enabled.
2. Specify a width in pixels, then click OK.
Dates and Date Ranges

In the calendar, you can specify dates and date ranges, or select a preset. You can make calendar selections at the project, workspace, and report levels. A project’s date range is the default date. However, a workspace date range overrides the project’s date range. Similarly, a report’s date range overrides the date settings of a workspace and project. You cannot select a date range outside your data availability range.

An enabled Clear Date option indicates that a date range is specified at the report level.

You can also drag dates (and Time dimensions) into the report or the Table Builder. You can select specific days, weeks, months, years, or a rolling date. If you use the custom calendar in marketing reports and analytics, a report suite inherits those settings and updates the report accordingly.

When selecting a date range while creating a project, using Pre-Configured on the left will set a rolling date while using the calendar on the right will not. An easy way to tell whether your date range is rolling is the statement “This date range will roll” next to the OK button.

Note: If you need help running legacy reports, contact your Account Manager.

Legacy Date Slices

In the second half of 2010, Adobe began the migration of report suites to a unified data platform for improved processing and storing. Data existing prior to the migration is considered legacy (or historical) data that is constrained by a calendar quarter or year boundary.

To access historical date slices
1. Create or open a project.
2. Open the calendar, then select **Quarter** or **Year**.

💡 **Note:** Historical date slices lie within quarter and year constraints. You cannot view data crossing the boundary between legacy slices and the new processing platform. Date ranges that span both results in an error. Additionally, the date ranges apply only to the Gregorian calendar, not to the Custom Calendar.
Dimensions

Dimensions are descriptions or characteristics of metric data that can be viewed, broken down, and compared in a report. They are non-numeric values and dates that correlate, sub-relate, or are a classification of the original report type metric.

Examples of dimensions include:

- Page, page names
- Products
- Gender
- Month
- Age
- Day, week, month, etc.
- Loyalty
- Monitor resolution
- Custom eVars and s.prop values

Dimensions Pane

The Dimensions pane lists and organizes all the product dimensions from your marketing reports and analytics implementation. You can base reports on any dimension item. You can break down dimensions by other dimensions to analyze and compare nearly anything.

In the Dimensions pane, you can search for dimensions and drag them to the Table Builder or the report detail table.

You can sort them based on the following categories:

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Traffic</td>
<td>Includes browser items, Target campaigns, geography, custom links, custom traffic properties, domains, downloads, referrers, referring domains, and so on.</td>
</tr>
<tr>
<td>Conversion</td>
<td>Includes campaigns, categories, custom eVars, products, tracking code, and so on.</td>
</tr>
<tr>
<td>Props</td>
<td>Includes custom traffic properties, such as entry and exit pages.</td>
</tr>
<tr>
<td>Evars</td>
<td>Includes eVars used as success metrics in data collection.</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Includes variables from hierarchies, used to determine the location of a page in your site's hierarchy.</td>
</tr>
<tr>
<td>Pathable</td>
<td>Includes any item that can be shown in a path, such as pages, download links, exit links, keywords, and referring domains.</td>
</tr>
</tbody>
</table>
Group Manager

Rather than using a single page in your report, you can group multiple pages and use them as categories for starting, intermediate, or destination location in the Fallout and Site Analysis reports. You can edit groups from the main menu, or from within the report. Categories that you have created in marketing reports and analytics also appear in the Checkpoint Selector list.

Click Tools > Group Manager.
Log File

The Log file is a text file that the server uses to store data relating to when files are retrieved from a website. Some of the information that is collected includes date and time, URL served, IP addresses, status of the request, and so on.

A quick way to save and view a log file is to:

1. Click Help > About Ad Hoc Analysis
2. Click the Ad Hoc Analysis logo.
3. Click Save Log File.

💡 Note: The log you save using this procedure is for the current session.
Metrics

Metrics are quantitative information about visitor activity, such as views, click-throughs, reloads, average time spent, dates, units, orders, revenue, and so on. Metrics and associated data are displayed in the columns of reports.

Standard metrics include:

- **Traffic**: Shows data about the volume of visitors.
- **Conversion**: Show data about success events on your website. Success events can include purchases, downloads, or any other action that you want users to take on your website.
- **Calculated**: Customizable metrics created by combining other metrics. For example, you could create a metric that subtracts the keyword cost and the cost of goods from the revenue to get net revenue. You could then divide this amount by the total number of orders to get average net revenue per order.

See [Metric Definitions](#) in the [Analytics Reference](#) for information about how metrics are used in the Marketing Cloud.

See [Calculated Metric Builder](#) for information about comparisons and calculated metrics.

Organizing Metrics

You can use the **Organize Metrics** tool to create new folders for your metrics. You can then group metrics any way you want. The organizer lets you copy existing metrics into your custom folders using drag-and-drop.

While you can create folders, name them, and organize the metrics into them however you want, you cannot change the default folders, except for the Favorites and Calculated Metrics folders.

Add Metrics to a Report

Steps that describe how to add metrics to a report.

1. In the **Metrics** tool pane, locate the metric.
   - You can locate metrics in the search field or by drilling into metric folders.
2. Drag the metric to the report table or **Table Builder**.
   - You may want to specify default metrics in **Settings** in advance, if you want to reduce the need to repeatedly add metrics to a report.
   - See [Ranked Tab - Definitions](#).

Organize Metrics

Steps that describe how to organize metrics and create metric folders.

1. In the **Metrics** tool pane, click **More Actions**.
2. Click **Organize Metrics**.
3. Click **New** to create a folder.
4. Select metrics in other folders, then drag the selection to the new folder.
5. Click **OK**.
Note: When you delete a folder, all of the metrics in the folder are deleted from your currently selected project.
Reports

Describes reports and what you can do with them.

Reports Overview

Standard reports display data for website and visitor activity, traffic patterns, referral data, advertising campaigns, visitor retention, product data, and more. You can run reports and then access tools to configure segments, metrics, and report comparisons.

You can gather custom data to create reports specific to your website. For example, if you have a search feature on your website, you can track the search terms submitted and create a report that shows these terms and the results of the searches.

The standard report set covers topics common to every website. Reports include (but are not limited to):

- Website data
- Visitor data
- Traffic patterns
- Referral data
- Advertising campaigns
- Visitor retention
- Product information

If you use marketing reports and analytics, the report types and menus will be familiar. Ad hoc analysis categorizes reports based on the following types:

Summary Reports

Includes reports such as the Totals Report, which shows data designed for quick overviews. These are intended for executives who want a general overview of the data.

Conversion Reports

Conversion reports provide comprehensive, accurate, and detailed analysis of customer activity. Metrics such as campaign management, sales cycle, customer fallout, and customer conversion let you measure e-commerce transactions, sources of sales, advertising effectiveness, customer loyalty, and more.

Traffic Reports

Traffic reports give you in-depth insight into how visitors interact with your website.

- Analyze critical aspects of visitor behavior.
- Monitor and understand traffic patterns.
- Determine popular site content.
- Segment visitors by any measurable criteria.

Statistical Calculations

You can customize the default statistics to show up in a ranked report.

Additional default statistical calculations can be added to ranked reports based to display when you run the report, including mean, median, standard deviation, and other mathematical calculations assessed across your data based on your specific reporting needs.
To open the statistical calculations for Ranked Reports:

1. Select **Tools > Ranked** from the menu.
2. Select **Settings**.
3. Select **Default Statistics**.

**Ignore zeros in statistical calculations.** Select this option to ignore zeros and ensure that adding another metric won't change the averages already calculated. All the statistics are affected by this setting (although for Sum it has no effect).

<table>
<thead>
<tr>
<th>Calculation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max</td>
<td>Identifies the maximum value across all rows for a specified dataset.</td>
</tr>
<tr>
<td>Min</td>
<td>Identifies the minimum value across all rows for a specified dataset.</td>
</tr>
<tr>
<td>Sum</td>
<td>A calculation of all the values for each row in the dataset. For example, the sum aggregates all visits by a visitor rather than counting the visitor only once (regardless of the number of visits). It is a comprehensive total of collected data points.</td>
</tr>
<tr>
<td>Mean</td>
<td>The mean is the arithmetic average of the values of rows in a dataset, calculated by the sum divided by the count (sum/count). The mean is influenced by outlying data, unlike the median which is generally used for skewed distributions.</td>
</tr>
<tr>
<td>Standard Deviation</td>
<td>The standard deviation shows how much variation exists from the expected mean. A lower standard deviation shows the data points close to the mean. A higher standard deviation shows that the data points are spread across a large range of values.</td>
</tr>
<tr>
<td>Median</td>
<td>The median is the numerical value separating the higher half of a data from the lower half for the rows in a dataset. Unlike the mean, it is generally used to avoid outlying values.</td>
</tr>
<tr>
<td>Quartiles</td>
<td>A quartile is the set of values in the dataset identified by three points that divide the data set into four equal groups, each comprising a quarter of the dataset. The first quartile is the 25th percentile, and the third quartile is the 75th percentile. (The second quartile is the Median and the fourth quartile is the Sum.)</td>
</tr>
<tr>
<td>Count</td>
<td>Returns the number of rows in a dataset.</td>
</tr>
</tbody>
</table>

**Example of Mean vs. Metric Total Calculations**

The Mean function is calculated similar to columns of data in Microsoft Excel. In particular, this means that the **Mean** of a ratio (such as determining the average bounce rate) would be the average of the ratios, not the ratio of the averages. The ratio of the averages includes the **Total** of the bounce rate metric.

<table>
<thead>
<tr>
<th>Date</th>
<th>Single Visits</th>
<th>Entries</th>
<th>Bounce Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>June 2013</td>
<td>344</td>
<td>1000</td>
<td>34.4%</td>
</tr>
<tr>
<td>July 2013</td>
<td>297</td>
<td>1000</td>
<td>29.7%</td>
</tr>
</tbody>
</table>
### Statistical Calculation Overlays

Ad hoc analysis now provides overlay visualizations of statistical calculations for reports that display data over time (minutes, hours, days, weeks).

In a report that identifies data over a period of time, the **Statistics** button lets you select calculations that will display as overlays across the report time line.

<table>
<thead>
<tr>
<th>Date</th>
<th>Single Visits</th>
<th>Entries</th>
<th>Bounce Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>August 2013</td>
<td>41</td>
<td>1000</td>
<td>41.0%</td>
</tr>
<tr>
<td>Mean</td>
<td>(344+297+41)/3</td>
<td>(1000+1000+100)/3</td>
<td>(34.4 + 29.7 + 41.0) / 3 = 35.0%</td>
</tr>
<tr>
<td>Metric Total</td>
<td>682</td>
<td>2100</td>
<td>682 / 2100 = 32.0%</td>
</tr>
</tbody>
</table>

In addition to standard **Statistical Calculations**, you can select the 1st, 2nd, and 3rd standard deviations in the overlays.

### Report Types

Descriptions of report types used in Marketing Cloud.

#### Ranked Reports

Displays a table with ranked items, using numbers and percentages in metrics. For example, a **Pages Report** ranks the pages on your site based on traffic, and the detail table shows percentages and numbers for metrics like Page Views and Revenue. A horizontal bar chart is the default graph type. Graphs display a color for each metric. Ranked reports can display multiple metrics in a report.

Ranked graphs default to five items, but you can graph up to thirty items in the chart options.

#### Trended Reports

Lets you examine how conversions and events trend over a selected time granularity (Hour, Day, Week, Month, Quarter, or Year) during a reporting period.
In the graph, the vertical axis displays the tracked items. The horizontal axis displays the time granularity. In the table, you can trend from a specific cell, and launch a full report from the cell. The date or time used is based on the cell’s value.

You can also select multiple cells and launch a trended report, based on a selected granularity. When you trend from multiple cells, the report columns display data for the entire reporting period.

A **Products Report** is an example of a trended report. You can see how much revenue a product made during the selected period. If your reporting period is a week, you can see how much revenue that product generated for each day of the time period, you can show a trend graph for a specific product on that day, or open a separate trended report for the selection.

**Trend from Cells**

Steps describing how to launch a trend report from one or more cells in a table.

**To trend from cells**

1. Open a ranked report.
2. In the table, locate the cell and click **Trend**.
3. To view a full report from the cell, click **Launch Trend Report**.

   Alternatively, right-click the cell, then click **Trend Cell**. You can also perform this task after selecting multiple cells.

**Totals Report**

An executive-level report that shows bottom-line figures. It contains data for total revenue, page views, and orders. You can segment the report and add additional metrics to view additional data.

**Flow Reports**

Flow reports show the most common paths users take across pages, site sections, and servers.

**Next Flow**

The **Next Flow** report group has three reports: **Next Page Flow**, **Next Section Flow**, and **Next Server Flow**. The reports in this group show you the most common pages, site sections, and servers that a visitor accessed after accessing the page, site section, or server you specify. These reports show you the most common paths taken through your website.

**Previous Flow**

Previous Flow reports are similar to Next Flow reports, except rather than seeing where visitors went after a selected page, you see where visitors were before visiting a specified page. The controls for using the report are identical to the controls for the Next Flow reports.

**Next Pages Flow**

Displays path views, or the number of times and percentages that a page was viewed within the constraints of the paths. For example, a Privacy Policy page might have 10,000 total page views, but only 500 of those page views occurred immediately before a Home Page. In this case, you would see 500 path views. You can view the report at the visit or visitor level. Percentages for each page are displayed beside the name of the page. The width of a line connected to a page depicts the relative percentage of visits.
By default, this report displays the top 10 pages that users went to following the page you select. You can click on any underlined page to further expand the graph. There is no limit to the number of pages you can have on the graph, and you can hover over a page to see visit and revenue data for the page.

Use this report to:

• Understand what steps are taken most frequently after viewing a selected page.
• Optimize your site path design to funnel your traffic to a desired goal page.
• Identify where visitors are going instead of your desired goal pages.

Next Server Flow
Displays the navigation data between servers on your site. When you select a server name from your site, the report shows you the number of visitors who navigated from that server to each of the other servers on your site within a single visit or across visits.

For example, if you have specific data on different servers or have mirrored data on separate servers, the report shows you the path between servers that the users hit. This is also true of domains within your website. For example, you can see how many users went from a www.mysite.com to info.mysite.com or sales.mysite.com.

Next Section Flow
The Next Section Flow report is similar to the Next Page Flow report. It displays data for Site Sections (groups of related web pages). If a page is contained in more than one site section, the report displays data for all site sections.

For example, an online retailer might have site sections for its products and site sections for product brands. In this case, a product web page can fall under multiple sight sections. Though a product page has only been viewed once, the Next Section Flow report shows a page view for each sight section associated with the page.

Previous Page Flow
Similar to the Next Page Flow report. The Previous Page Flow report displays multiple levels of the most popular pages that your visitors view before the selected page. The report also highlights pages from which visitors enter your site.

Use this report to:

• Understand what steps are taken most frequently before viewing a selected page.
• Optimize your site path design to funnel your traffic to a desired goal page.

Previous Section Flow
The Previous Section Flow report is similar to the Previous Page Flow report. It displays data for Site Sections (groups of related web pages). If a page is contained in more than one site section, then the report displays data for all site sections.

For example, an online retailer might have site sections for its products and site sections for product brands. In this case, a product web page can fall under multiple sight sections. Though a product page has only been viewed once, the Previous Section Flow report shows a page view for each sight section associated with the page.

Previous Server Flow
This report shows you navigation data between servers on your site. When you select a server name from your site, the report shows you the number of visitors who navigated to that server from each of the other servers on your site within a single visit or across visits.
For example, if you have specific data on different servers or have mirrored data on separate servers, the report shows you the path between servers that the users hit. This is also true of domains within your website. For example, you can see how many users went from a www.mysite.com to info.mysite.com or sales.mysite.com.

Conversion Funnel Reports

Conversion Funnel reports show conversion percentages between specific metric events. You can use this report to understand the number of click-throughs that generate sales, and the number of units sold. For example, a Products Conversion report shows the percent of Carts events related to Visits events, and then displays totals for Orders, Revenue, and Units based on those events.

The following funnel reports are available:

• **Purchase Conversion Funnel**: Shows Visits (Report-Specific), Carts, Orders, Units, and Revenue.
• **Cart Conversion Funnel**: Displays Visits (Report-Specific), Carts, Checkouts, Orders, and Revenue.
• **Custom Event Funnel**: Displays custom events on your site. It shows custom events 1-5 by default.
• **Campaign Conversion Funnel**: Shows Click-throughs, Checkouts, Orders, and Revenue.

The report table shows statistics for average sales per click-through, and average units sold per click-through. You can add metrics and custom events from other reporting groups to these reports. These funnels have many similarities but are based on different variables and events. You can use these reports to see what percentages and general trends of users fire specific events you specify. You can see where users are not following through to events, which provides insight to that specific point in the conversion process.

Site Analysis Report

Site Analysis displays how visitors move through specified pages and events. For example, you can see the flow of traffic between pages, the affinity between products and marketing channels, and how campaigns and channels flow to product orders. You can drag pages, dimension items (and lists), and metric events. Each cylinder represents one or more dimension items (pages) or an event. Arrows represent the flow between the cylinder values. Metrics are assigned to cylinder positions (X and Y), cylinder width, cylinder height, and color. The position, size, and color changes depending on the metric values.

Drag items from tool panes to add them to the graph or the dimensions field.

Right click cylinders to edit or remove them.

Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Site Analysis At (Visit or Visitor)</td>
<td>Lets you switch between Visit and Visitor to analyze visitor pathing. These settings help you understand visitor engagement at the visitor level, across visits. Site Analysis, Flow, and Fallout reports are enabled for visitor pathing. Changing this setting reruns the report, constraining the data to the selection.</td>
</tr>
<tr>
<td>Add Checkpoint</td>
<td>Displays the Checkpoint Editor, from which you can select dimensions or events to add to the display.</td>
</tr>
<tr>
<td>Replace Chart</td>
<td>Replaces the Site Analysis chart with the checkpoints you add to the editor.</td>
</tr>
<tr>
<td>Fit to Screen</td>
<td>Restores a chart's original view.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Aerial View</td>
<td>Provides a topdown view of the chart.</td>
</tr>
<tr>
<td>Toggle Grid</td>
<td>Toggles the grid on or off.</td>
</tr>
<tr>
<td>Dimension</td>
<td>The item on which you are reporting. Drag the item from Dimensions.</td>
</tr>
</tbody>
</table>

### Right-Click Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Lets you add or remove pages to a cylinder.</td>
</tr>
<tr>
<td>Remove</td>
<td>Lets you remove a cylinder.</td>
</tr>
<tr>
<td>Reports</td>
<td>Lets you launch another report from the cylinder.</td>
</tr>
<tr>
<td>Save Chart As</td>
<td>Lets you save the chart as a <code>.png</code> or <code>.jpg</code>. If you change the chart controls (graph angle, size) before saving, the changes are preserved in the output.</td>
</tr>
<tr>
<td>Copy Chart to Clipboard</td>
<td>Copies the chart for pasting into another application. If you change the chart controls (graph angle, size) before saving, the changes are preserved in the output.</td>
</tr>
</tbody>
</table>

### Site Metrics Reports

Displays quantitative information about your website, such as how many times visitors looked at certain pages, numbers of overall purchases made from specific pages, when they came, and similar quantitative data. Each of these reports is a metric that you can place in other item-based reports.

Metric reports are trended over time. You can apply time and day-of-week granularity to these reports. Alternatively, you can analyze the time spent on your site, purchases, revenue, and similar metrics.

The following Site Metrics reports are available in the **Site Metrics** menu.

### Page Views Report

A trended report that displays the number of times your website pages were viewed for the selected time period (hour, day, week, month, quarter, or year). A **Page View** is a request for a full page document, rather than an element of a page, such as an image or video. For example, if a single visitor views 15 pages during a visit, 15 page views are counted. If a visitor views the same page three times during a visit, three page views are counted. This report allows you to track page views for each page on your site, as well as an aggregate of page views for your entire site.
Visits Report

Displays the number of visits made to your entire website during a specified time period. A visit is a sequence of page views. A visit begins when a visitor loads a page, and the visit ends after 30 minutes of inactivity. A visit can last several hours, as long as the visitor loads at least one page before the timeout. A visit does not necessarily coincide with a browser session. For example, if a visitor closes the browser, reopens the browser, and comes to your site five minutes later, it is recognized as a continuation of the same visit. This also means that if a visitor stares at one page for 35 minutes, the visit will have closed and processed, and a new visit will start if they click through to another page. Visits are tracked by cookies. A visit is terminated after 12 hours of continuous activity.

In marketing reports and analytics, you can run a Visits Report on a selected page. In ad hoc analysis, you can segment the data to view specific pages.

Unique Visitors Report

A trended report that shows you the number of unique visitors who accessed your site. Each visitor is counted once regardless of how many times the person visits your website. Adobe uses a patent-pending cookie-handshake technology to distinguish a unique visitor from a return visitor. The cookie handshake overcomes limitations in Internet browser cookie technology.

You can use this report to:

• See the number of different people that viewed your website during any given time period.
• View recent traffic patterns and learn how promotions are bringing unique visitors to your site.
• Compare the number of your unique visitors to the number of page views.

Visitors Report

Shows the number of unique visitors to your site for a selected hour, day, week, month, quarter, or year. A unique visitor is counted only one time for the selected time frame. Visitors that return to your site are not counted as unique users again until the time frame has passed.

The total value displayed at the bottom of the table is the sum all of the visits for the specified time period and does not always reflect the number of unique visitors. For example, if you run a Daily Unique Visitors Report with a time frame of several days, the total can include repeat visitors, because the same visitor might return on the next day and be counted again. However, if you run a Monthly Unique Visitors Report, the value in the Totals column accurately reflects how many unique visitors came during the month.

Time Spent per Visit Report

For more information on Time Spent metrics and dimensions in Adobe Analytics, click here.

Purchases Report

Displays summary data for Revenue, Orders, and Units. You can also view the Purchase Conversion Funnel report.

• Revenue: Lets you view gross profits for selected time periods. Examples could include revenue during the month of March, purchases made last week, or revenue for today.

• Orders: Shows the number of orders made on your website during the specified time period. Orders can have multiple products in them.

• Units: Shows the total units that were ordered for the specified time period.
• Purchase Conversion Funnel: Ideal for showing conversion events on your site if they occur in a specific order, such as in a retail setting. A funnel report shows you the conversion metrics for each step of the conversion process as well as Orders, Revue, and Units.

Shopping Cart Report
Displays the number of shopping carts that are opened during the specified time period. You can run reports to analyze cart views, additions, removals, and checkouts. A shopping cart is usually opened when a customer selects an item for purchase, but can occur without an item as well.

You can use the Carts Report to:
• Determine patterns, highs, or lows in the number of carts opened on your site.
• Examine specific time periods learn more information about the metrics that specifically contributed to the opening of the cart.

Custom Events Report
The conversion actions on your site that you want visitors to complete. These actions might be a registration, a subscription, a lead form completion, a chat initiation, a purchase, a booking, or a finished survey.

Because each analytics report suite differs, this set of reports is used differently for each client. A Custom Event report can be used as a counter that shows the number of times an event occurs. For example, if event1 is set to count the number of times a document is downloaded, then the Custom Event report for Event 1 shows the total number of times the event (or download) occurs. You can have multiple custom event reports.

Totals Report
An executive-level report that shows bottom-line figures. It contains data for total revenue, page views, and orders. You can segment the report and add additional metrics to view additional data.

Site Content Reports
Displays information about which pages and areas of your site are most active and which servers are getting the most use.

Pages:

Site Sections:

Hierarchy:

Servers:

Links:

Pages Report
Ranks the pages on your site based on the pages that receive the most traffic. If your business question deals with quantitative data for pages, you can use this report to answer that question, by adding the right metrics.
Site Sections Report

Shows the areas of your site that are accessed most by your visitors. Site Sections can include groups of products, similar to categories, which you define. For example, you might have a Cameras group of pages, a Computers group, and so on. Data for the Conversion Site Sections report is imported from the Site Section report in the Traffic group, which receives its information from the channel variable in the marketing reports and analytics tracking code. You can use this report to identify the greatest impact on site statistics from items in varying site sections.

Hierarchy Report

Shows you the hierarchical layout of the pages on your website and displays those pages in order based on how they are configured in the $hierN$ variable. This report is populated using proper variable configuration that you set for each page that you want to take part in the hierarchy. This report lets you see selected metrics (such as Unique Visitors) for the hierarchy.

Servers Report

Lets you group pages that are hosted by a particular server. This report lists all of the servers of your website that marketing reports analytics tracks, and tells you which servers are being accessed the most. For example, if you have a website that is hosted on two different servers, you might want to see if one server is serving more impressions than the other server.

Links Report

Shows you the links that visitors click when on your website, including links clicked to leave your site, or download links.

Reports include:

- **Exit Links**: Displays links that the user clicked to leave your website. These links include links to partner or affiliate websites.

- **File Downloads**: Displays the files that have been downloaded from your website. These files can be any type of file you want to track, including user manuals, presentations, audio, or video files. This report requires that link tracking code is installed on the site that you are tracking. See the Analytics Implementation Guide for more information.

- **Custom Links**: Shows you the links your site visitors prefer, helping you understand the navigation patterns within your site. For example, the Home page for your site likely has multiple links that access the same page. Perhaps there is graphic and text link that both link to the same page. This report shows what percentage of visitors use the graphic link versus the text link. Custom links are specific to your website. The specific links that you want to track must be modified with special tags. For assistance, contact ClientCare.

Mobile Reports

Displays information about websites access from a mobile device. Mobile reports improve visitor identification by collecting data about mobile devices used to view your site. Mobile reports can identify a device’s manufacturer and capabilities, such as screen sizes, video, audio, and cookie support, and other metrics. Mobile reports are available for all report suites.

To improve visitor identification for mobile devices, you must be on the carrier’s list (white list) for sending subscriber IDs to a domain. (You can view the carrier in the Visitor Profile > Domains report.)
Note: To view reports on a mobile a device, login to the Marketing Cloud mobile site at mobile.omniture.com.

For more information about mobile tracking, see the Mobile Solutions site.

Devices Report
Displays the number of visitors that accessed your site using mobile devices, such as devices running iOS or Android. This report can help you understand the impact of mobile initiatives so you can plan accordingly.

You can use this report to:
• Develop strategies that address mobile users
• Identify your audience's preferences
• Track the emergence of wireless and mobile users

Manufacturer Report
Groups mobile device hits to your site by mobile device manufacturer. The report displays the type of manufacturer, number of views for each manufacturer, and the corresponding percentages.

Screen Size Report
Groups mobile device hits to your site by the screen size of the device. The report shows each screen size, the number of visitors to your site that used each screen size, and each screen size as a percentage of the total views. The Screen Size report shows both the height and width of the screen size as compared to the Screen Height report and Screen Width report.

Screen Height Report
Shows the screen height for various mobile devices and the number of views for each screen height. You can also view the Screen Size report to see both the screen height and width.

Screen Width Report
Shows the screen width for various mobile devices and the number of views for each screen width. You can also view the Screen Size report to see both the screen height and width.

Cookie Support Report
Groups mobile device hits by whether they support cookies or not. Visitors are divided into groups the support cookies and groups that do not. The type of mobile device is identified in the user agent string. Adobe maintains a list of mobile devices that are known to support cookies. If the mobile device listed in the user agent string is also listed in Adobe's list of mobile devices, then the Supported line item in the Cookie Support report is incremented. Otherwise, the Not Supported line item in the report is incremented.

Image Support Report
Groups mobile devices based on the types of images they support. For example, if a visitor's phone that supports .jpg images, accesses a site, the Image Support report is incremented by at least one. If the phone supports more than one image format, then a visit to a site might result in multiple increments for that visit. In other words, if your phone supports .jpg, .png, and .gif formats, then each of those groups in the report is incremented. As such, the sum of the groups might be greater than the total shown at the bottom of the report.
Color Depth Report

Groups mobile device hits by the number of colors supported. The report shows the total number of visitors to your site who used a mobile device, and breaks them into groups based on the number of colors configured in their mobile devices. For example, if your visitor’s mobile phone supports 24 colors, then marketing reports and analytics increments the line item corresponding to 24 colors.

Audio Support Report

Groups mobile devices based on the types of audio formats they support. For example, if a visitor’s phone supports the .mp3 format, the Audio Support report increments by at least one. If the phone supports more than one image format, a visit to a site might result in increments for each supported audio type. In other words, if a phone supports .mp3, .aac, and .amr formats, then each of those groups in the report is incremented. As such, the sum of the groups might be greater than the total shown at the bottom of the report.

Video Support Reports

Groups mobile devices based on the types of video formats they support. For example, if a visitor’s mobile device supports .mp4, the Video Support report increments by at least one when it accesses your site. If the phone supports multiple image formats (such as .mp4 and .wmv), each of those groups in the report is incremented. Because of this, the sum of the groups might be greater than the total shown at the bottom of the report.

DRM Report

Groups mobile devices based on the type of Digital Rights Management (DRM) they support. DRM groups include Forward Lock, Combined Delivery, Separate Delivery, and Unknown.

Net Protocols Report

Groups mobile devices based on the network protocols (GPRS, CSD, EDGE, HSCSD, and so on) that they support. The report also includes an Unknown group for unidentified network protocols.

When a visitor uses a mobile device to access your site, the Net Protocols report increments by at least one. If the phone supports multiple network protocols then each of those groups in the report increments. Because of this, the sum of the groups might be greater than the total shown at the bottom of the report.

Operating System Report

Groups mobile devices based on the mobile operating system running on the device. Mobile operating systems include Windows, RIM, iOS, Symbian, and so forth. The report also includes an Unknown group for unidentified mobile operating systems.

Java Version Report

Groups mobile devices based on the Java version that they support. The Java Version report identifies the Java version by the Java Specification Request (JSR) supported by the device. The report also includes an Unknown group for unidentified mobile operating systems.

You can find out more about a given JSR at the Java Community Process website.

Bookmark URL Length Report

Groups mobile devices based on the maximum supported length, in characters, of a bookmark URL.
Mail URL Length Report
Groups mobile devices based on the maximum supported length, in characters, of an email URL.

Browser URL Length Report
Groups mobile devices based on the maximum supported length, in characters, of a Web browser URL.

Device Number Transit Report
Groups mobile devices based on whether Device Number Transmit is supported. The report also includes an Unknown group for those devices where Device Number Transmit support cannot be determined.

PTT Report
Groups mobile devices based on whether the device supports Push To Talk (PTT). The report also includes an Unknown group for those devices where PTT support cannot be determined.

Decoration Mail Support Report
Groups mobile devices based on whether the device supports DecoMail, which allows a user to decorate their mail with graphics and animations. The report also includes an Unknown group for those devices where Decoration Mail support cannot be determined.

Information Services Report
Groups mobile devices based on the news services (Channel I/B, EZ News Flash, W+INFO, and so on.) that they support. When a visitor uses a mobile device with news service support to access your site, the Information Services report increments by at least one. If the phone supports multiple news services, each of those groups in the report increments. Because of this, the sum of the groups might be greater than the total shown at the bottom of the report.

Paths Reports
Displays information about the order in which pages of your website are accessed. You can gather information about where a visitor goes before and after any page visited on your site.

Paths reports include standard in-depth and optional advanced analysis reports that reveal the click-stream of pages viewed. You can uncover full paths, longest paths, and most popular paths; explain page flow, fallout, and dropout graphically; show new and changing patterns over time; and analyze entry and exit paths.

Next Page Flow or Next Site Flow: Displays a two-level-deep branching graphic of a selected page (or section, department, and so on), that your visitors view after moving away from the selected page. Use this report to analyze and identify the steps your visitors take most often after viewing a selected page. You can:

• Understand what steps are taken most frequently after viewing a selected page.
• Optimize your site path design to funnel your traffic to a desired goal page.
• Identify where visitors are going instead of your desired goal pages.

Next Page (or next categories): Provides detailed site path analysis by showing you the pages on your site that visitors viewed after seeing a selected page. For example, when selecting and reporting on your entire site, the report shows you the top ten landing pages, with the five most popular next pages listed below each landing page. This data can help you understand which content, features, and other data, most often compel your visitors to move through your site.
Previous Page Flow (or other previous categories flow): Displays two levels of the most popular pages that your visitors view before the selected page. The report also highlights when visitors enter your site.

Previous Page (or other previous categories): Provides detailed site path analysis by showing you the pages on your site that visitors viewed before seeing a selected page on your site.

Fallout: Displays the visit attrition and conversion rates between each checkpoint you define. Steps are arranged top-to-bottom, with raw numbers and percentages shown on the left, and conversion and fall-out percentages on the right.

See Fallout Report for more information.

Path Length: Shows how deep visitors browse into your site (both by percentage and by total count). In other words, the report indicates how many pages the average visitor to your site views before leaving.

Page Analysis: Contains a subset of reports that let you analyze the following:

- **Page Summary / Site Category Summary**: Tells you everything you need to know about the page report. It collects and organizes page-specific information about a single page and presents it in a single report.
- **Reloads**: Shows the number of times individual pages were reloaded by visitors.
- **Time Spent on Page / Site Category**: Displays the length of time that visitors browse individual pages in your site. The time spent is divided into ten categories: less than 15 seconds, 15-30 seconds, 30-60 seconds, 1-3 minutes, 3-5 minutes, 5-10 minutes, 10-15 minutes, 15-20 minutes, 20-30 minutes and greater than 30 minutes.
- **Clicks to Page**: Identifies the number of clicks visitors used to access each page in your site. Depth for a page is measured by counting the number of pages viewed before it.

Entries & Exits: The Entry Page report shows you, by percentage and by total visits, which pages on your site are the first ones seen by new visitors. You can view:

- **Entry Pages** (or sections): Displays, by percentage and by total visits, which pages on your site are the first pages seen by a new visitor. You can use this report to identify which of your web pages are the most frequent points of entry, optimize the primary entry points on your site, and drive entry traffic to your key messages.
- **Original Entry Pages**: Shows the first page viewed for first-time visitors to your site. Each user is counted only once unless they delete their cookies or are not being tracked with cookies.
- **Single Page Visits**: Shows pages that are most often both the entry and exit pages for visitor browsing sessions.
- **Exit Pages**: Displays, by percentage and by total visits, the pages on your site that were the last pages visitors viewed before leaving your site.

Fallout Report

The Fallout Report shows where visitors leave (fallout) and continue through (fallthrough) a pre-specified sequence of pages. It displays conversion and fallout rates between each step. For example, you can track a visitor’s fallout points during a buying process. You select a beginning point and a conclusion point, and add intermediate points to create a website navigation path.

You can analyze fallout data at the Visit or Visitor level. You can also see a trended path that shows you a graph of your fallout over a specific period. You can set single or groups of pages as the report checkpoints, or add any dimension or metric in any combination or sequence. You can also use categories that you configure in marketing reports and analytics as checkpoints in this report.

This report is useful to analyze:

- Conversion rates through specific processes on your site (such as a purchase or registration process).
- General, wider-scope traffic flows: Of the people who saw the home page, this flow shows how many went on to perform a search, and then how many of them eventually went on to look at a specific item.
• Correlations between events on your site. Correlations show what percentage of people who looked at your privacy policy went on to purchase a product.

**Run a Fallout Report**

Steps to run a Fallout Report.

1. Click **Reports > New Report > Fallout**.
   
   Other Fallout reports are found in **Reports > Paths**.

2. (Optional) Drag a segment to the **Drop Segment Here** field, if you want to filter the data by a specific segment.
3. Drag any dimension item to the **Drop Event or Dimension Items Here** field.
4. Click **Show Fallout At** Visit or Visitor level, depending on whether you want to view fallout at the visit level, or across visitor sessions.
5. Add dimension items, such as pages, to the report.

**Assign Pages to a Fallout Report**

Steps to assign pages to a fallout report.

1. Click **Reports > Paths > Pages > Pages Fallout**.
2. From the **Dimensions** pane, locate the pages to add, then drag them to the **Drop Event or Dimension Here** field.

**Fallout Report - Field Descriptions**

Field descriptions for the Fallout report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Fallout At Visit or Visitor Level</td>
<td>Lets you switch between Visit and Visitor to analyze visitor pathing. These settings help you understand visitor engagement at the visitor level, across visits. Site Analysis, Flow, and Fallout reports are enabled for visitor pathing. Changing this setting reruns the report, constraining the data to the selection.</td>
</tr>
<tr>
<td>Total Success</td>
<td>A total indicator of success. This value reflects the value in the last checkpoint of the path.</td>
</tr>
<tr>
<td>Total Success %</td>
<td>A cumulative total of the percentage of visitors arriving at each checkpoint.</td>
</tr>
<tr>
<td>Checkpoint %</td>
<td>The percentage of success between checkpoints. (Not cumulative.)</td>
</tr>
<tr>
<td>Include All Visits</td>
<td>Adds all visits as the initial checkpoint.</td>
</tr>
<tr>
<td>Fallout</td>
<td>Lets you see the pages viewed after the visitor fell out of the specified checkpoint path.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Fallthrough</td>
<td>Lets you see the pages viewed in the next step of the specified checkpoint path.</td>
</tr>
</tbody>
</table>

**Traffic Sources Reports**

Traffic sources reports give you in-depth insight into how visitors interact with your website.

Traffic sources reports let you:

- Analyze critical aspects of visitor behavior.
- Monitor and understand traffic patterns.
- Determine popular site content.
- Segment visitors by any measurable criteria.

**Common Persistence**

In Traffic Sources, all report values persist and receive credit until they are overwritten or until the visit ends, whichever comes first. Previously, only Keywords and Referring Domains persisted. For example, if a visitor performs a Google search for "DVD," which brings them to your site for a $100 purchase, the report allocates $100 credit to the keyword "DVD" and also to the Google search engine. This functionality is unalterable, regardless of Admin Console settings.

**Search Keywords**

Displays a breakdown of keywords for All, Paid, and Natural searches.

**Search Keywords - All**: Displays a breakdown of each search keyword that has been used to find your site. You can sort this list by page views or search keywords by clicking the column title above the listing. Click the magnifying glass next to a search keyword to see the search results for your site.

**Search Keywords - Paid**: Displays a breakdown of each paid search keyword that is used to find your site. You can sort this list by page views or search keywords by clicking the column title above the listing. Click the magnifying glass next to a search keyword to see the search results for your site.

**Search Keywords - Natural**: Displays a breakdown of each natural search keyword that is used to find your site. You can sort this list by page views or search keywords by clicking the column title above the listing. Click the magnifying glass next to a search keyword to see the search results for your site.

**Search Engines**

Displays which search engines visitors use for All, Paid, and Natural searches.

**Search Engines - All**: Displays which search engines that people are using to find your web page. The graph shows you the percentage breakdown of the search engines that are used to find your site.

**Search Engines - Paid**: Displays which paid-keyword search engines that people are using to find your web page. The graph shows you the percentage breakdown of the search engines that are used to find your site.
Search Engines - Natural: Displays which natural-keyword search engines people are using to find your web page. The graph shows you the percentage breakdown of the search engines that are used to find your site.

Referring Domains

Shows the domains that referred the customers that most impacted your site’s success metrics. Referrers fall into two main categories: Domains and URLs. Domains refer to the domain name, and appear as the base domain without the query string or subdirectories attached. URLs include the base domain name, as well as any query strings or subdirectories.

Original Referring Domains

Displays the original referrers that produced the customers on your site. Customers can visit your site multiple times, and have a different referrer for each visit. This report shows how they were referred the first time they arrived at your site. This can help you see if they continued to use the same referrer, and view patterns in how customers are referred to your site. You can view the number of visitors generated by an original referrer or find out how much revenue each original referrer was responsible for producing. Referrer reports can be populated each time a visitor comes to your site, even if the visitor comes to the site multiple times during a session (before the visit expires.)

Referrers

Displays the domain or URL where your visitors came from before they arrived at your site, the methods visitors use to find your website, and the number of visits to your site that came from these referring locations.

For example, if a visitor clicks a link from Site A and arrives at your site, Site A is the referrer if it is not defined as part of your domain. During marketing reports and analytics implementation, your implementation consultant can help you to define the domains and URLs that are part of your website. (This change can be done after implementation.)

Domains or URLs that are not part of those defined domains and URLs are considered referrers. For example, web page A and web page B are added to the internal URL filter, but web page C is not. In this case, web page C is considered a referrer.

See Internal URL Filters in the Admin Console help for more information.

💡 Note: Marketing reports and analytics records a referring domain as an email when visitors click an emailed message link containing the protocol imap:// or mail:// and arrive at your site. For example, anything coming from http://mail.yahoo.com is not counted as an email referrer because the protocol is http://. Emails from Outlook are reported in the Typed/Bookmarked line, while any referrer with an HTTP protocol where the domain is a known search engine is reported in the Search Engine line.

Referrer Type

By tracking and recording the visitors’ referring sites for each visit, you can determine how visitors found out about your site for each visit.

The list below defines the various types of referrers:

* Other website referrers are recorded when visitors click a link located on a page on another website (not defined as part of your site) and arrive at your website.

* Search engine referrers are recorded when visitors use a search engine to access your site.

* Typed/Bookmarked referrers are recorded

* If a visitor enters your site via a non-browser link (for example, in an email).
• If a visitor types your site’s URL directly into their browser.
• If a visitor clicks an HTML link on his or her personal hard drive.
• If a visitor accesses your site by selecting browser bookmarks.

Definitions
The following line items might display when running this report:

**Inside Your Site:** These items are URLs that are tagged by the internal URL filters. These items are not counted as referrer instances but can be seen when reporting on other metrics.

**No JavaScript:** There was no JavaScript so the type was unidentifiable (unknown). This means that there was no referrer information provided by a client on a browser, which does not report being able to support Javascript. These are not counted as "referrer instances" but can be seen when reporting other metrics.

**USENET (newsgroup):** This means that the URL of a referrer started with `news://`. As such, the referrer link was posted on a Usenet newsgroup rather than a web page.

💡 *Note:* Referrer Type logic matches other traffic sources reports (such as *Referrers* and *Referring Domains*). This should reduce or eliminate the occurrences of the Inside Your Site and No JavaScript line items in the Referrer Type report.

**Campaigns**
Displays information about the effectiveness of your advertising efforts. You can see which types of advertising efforts give you the most traffic and which of your employees is responsible for driving those efforts.

These reports are usually customized and thus different for every analyst. See *Campaign Manager* in the Admin Console help for more information.

**Products**
Displays information about the things you are selling, distributing, or displaying on your website. You can see data on orders or downloads for your products, applications, or content.

**Products Conversion Funnel**
Shows averages for the Product Views, Cart Additions, Orders, Revenue, and Units metrics. It also shows key conversions between important data in each reporting group and standard conversion metrics (Orders, Units, and Revenue). The top (overview) of the funnel provides a visual summary of conversion data. The funnel section shows statistics for all events in the overview section based on Orders and up to two other metrics, such as Revenue and Units.

To add metrics and custom events from other reporting groups, click a *Selected Events* link in the report header.

Because the current time periods are not yet completed when you view data, this report can indicate a downward trend from the previous to the current time period. For example, there can be fewer visits today than yesterday, but only because the rest of the time period’s statistics have yet to occur.
Products
Displays information about the things you are selling, distributing, or displaying on your website. You can see data on orders or downloads for your products, applications, or content.

Categories
Shows how various product categories affect your site's success metrics.

Visitor Retention
Displays information about your customer loyalty. You can see how many and how often visitors return to your site. Reports in this category display information about customer loyalty. You can see how many and how often visitors return to your site.

Return Frequency
Shows the length of time that passes between visits from returning visitors, and the number of visits that fall into each time length category. Use the report to see the average amount of time that repeat visitors go without visiting your site, and the trends in repeat customers.

For example, showing the Orders metric in this report helps a retail site understand the most effective time between visits in generating conversion. Use this information to market effectively to visitors who have gone a certain period of time without visiting your site.

You can:
• Identify the number of return visitors and the frequency of their return visits.
• Evaluate your website's appeal and relevance to visitors over time.
• Know how sticky your site is to visitors and how often they feel compelled to return for further interaction or updates.
• Identify the impact of your website's content and promotions on your visitors.

By default, this report has the following time lengths:
• Less than one day
• One to three days
• Three to seven days
• Seven to fourteen days
• Fourteen days to one month
• Longer than one month

Visit Number
Shows which customer visit numbers on your site most influenced your success metrics. A visitor making a first visit to your site is counted in the Visit Number 1 line item. Visitors that return to the site for a second visit are counted in the Visit Number 2 line item, and so forth.

You can use this report as a fallout report to see whether visitors are returning. You can also add a revenue metric to see whether you generate more revenue from initial visits or subsequent visits.

For example, this report could answer questions such as: Did customers who purchased on their fourth visit generate more revenue than those who purchased on their first visit?

You can break down this report by any other report or variable to determine:
• How many visits does it typically take a user who clicked through campaign XYZ to make a purchase.
• Whether users in Tokyo, for example, make more visits before generating a lead than users in London.

💡 **Note:** *If the same visitor visits your website multiple times in the same period, each specified visit number is incremented for each visit.*

This report is based on the visitor ID data that is passed to Adobe on every hit made by visitors. As this data is received, Adobe compares it to historical visitor ID data to determine whether the hit is:

• A new visitor (Visit Number equals 1).
• A previous visitor continuing a visit (Visit Number is not incremented).
• A previous visitor making a new visit (Visit Number is incremented by one).

💡 **Note:** *Each Analytics visitor ID is associated with a visitor profile on Adobe servers. Visitor profiles are deleted after at least 13 months of inactivity regardless of any visitor ID cookie expiration.*

### Customer Loyalty

Use this report to see whether your revenue is most affected by new customers or by repeat customers.

The **Customer Loyalty** report displays purchasing patterns of customers based on four categories of loyalty:

• **Not a Customer**: Visitors that have never purchased
• **New Customer**: Visitors that made a single purchase
• **Return Customer**: Visitors that made 2 purchases
• **Loyal Customer**: Visitors that made 3+ purchases

💡 **Note:** *When using these metrics, all user Visits (or all Visitors) are represented in this report, regardless of whether the Visit (or Visitor) included a purchase.*

The loyalty state changes after the end of the visit where a purchase event occurs. For example, a New Customer (1 purchase) makes a purchase and then registers for a newsletter after that purchase within the same visit. The newsletter registration event is still considered a New Customer interaction, because the visitor’s Customer Loyalty state will not change until the next visit.

### Visitor Profile

Displays information about the type of visitor that comes to your site. You can see things like location of the visitor, the type of browsers and computer hardware used, languages used, and Internet service provider data for your visitors.

**Languages**: Displays your visitors’ preferred languages, captures the default browser language, and displays the languages that visitors use most often on your site.

**Domains**: Lists the organizations and ISPs your visitors use to access your site. This report differs from the **Full Domains** report in that the Full Domains report registers the full ISP domain, whereas this report lists the secondary domain.

**Top Level Domains**: Identifies world regions that visitors come from based on their originating domain extension, and shows how many visitors come from these countries. Domains ending in Commercial (.com), Network (.net),
Education (.edu), Government (.gov) and Organization (.org) are usually based in the United States, and are listed separately from the rest of the domains.

**Visitor ZIP/Postal Code** : Displays the zip and postal codes that produced the customers that had the greatest effect on purchase success metrics.

**GeoSegmentation**

Shows the geographic dynamics of your visitors in real-time, including the countries, states and cities from which they are browsing. You can also gain important insights into the technology and preferences of your website's audience.

**Conversion Reports**

Shows revenue gained from different aspects of your website. You can see reports that show revenue from ad campaigns, revenue from loyal customers compared to revenue from new customers, a breakdown of revenue by product, and many other revenue reports. Conversion reports can also show other success events such as ad clicks, downloads, or other events.

Conversion reporting includes real-time statistics on all important customer activity, including:

- Customer purchase patterns
- Shopping cart metrics, including fallout
- Customer conversion rates
- Advertising and channel partner effectiveness
- Online and offline marketing campaign performance
- Customer loyalty metrics
- Insight into sales cycles

**Custom**

Administrators can configure a report with specific metrics and a specific date range, and then save it to the report menus for everyone to use.

Custom reports can bring increased value to you as an analyst, because they have been deemed worthy of being in everyone’s marketing reports and analytics menu. If you see reports in your interface that don’t match someone else’s (such as in Training), your admin may have set up some of these custom reports.

Additionally, you can save reports that are important to you. These reports are called bookmarks. You can also put several reports onto one canvas to get a quick look at your most important reports. These are called dashboards and are also user-specific. The interface displays a bar above the graph listing your bookmarks and dashboards.

**Adobe Target**

View and segment your Adobe Target traffic data in an Analytics report.

Examples include:

- Measuring the success of Adobe Target campaigns through your Analytics KPIs.
• Breaking down Target campaign and recipe data with Analytics conversion variables.
• Breaking down other Reports and Analytics reports with Target campaign and recipe traffic data.

By leveraging data in Reports and Analytics, you can drill into your Target recipes using breakdowns and detect high performing segments that are ideal for future tests and potentially targeted campaigns. The Reports and Analytics report displays conversion data rather than Target's conversion data.

See the Adobe Target help system for more information.

**Marketing Channel Reports**

Marketing Channel reports display the first and last-touch channel allocation, with critical, standard metrics like revenue, orders, and cost, letting you know how much revenue each channel generates. You configure channel definition rules in the Admin Console, and APIs specific for the channel reports are available.

**First or Last Touch Channel Report**: Displays metrics showing data about a specific first-touch or last-touch channel. In these reports, you can break down a channel and show the details of each channel. If you have AdLens enabled, you will see classifications in your marketing reports and analytics channel reports.

**First or Last Touch Channel Detail Reports**: Displays details such as page names and referrers, which is taken from the channel values you set up in the Set the channel's value to option when configuring rules. Channel detail reports let you closely examine the channel detail values from the overview report.

For more in-depth information about configuring the Marketing Channel in marketing reports and analytics, see the Marketing Channel Help system.
Building Segments

Ad Hoc Analysis integrates with the Unified Segmentation environment, allowing you to build, share, manage, and apply visitor segments across Adobe products. Ad Hoc Analysis provides a Java-based user interface for its Segment Builder and Segment Manager identical to the web-based tools used by other Analytics tools like Reports and Analytics, Data Warehouse, Report Builder, matching server calls and providing the same features and functionality from a Java-based console.

Ad Hoc Analysis includes familiar features for building segments, plus new feature upgrades like the Segment Manager used to set up a segment management workflow. As always, you can build and save segments in the Segment Builder or generate segments from a Fallout report from the ad hoc analysis console, and then save the new or extended segments to the audience library for general access and application.

Unified Segmentation in Ad Hoc Analysis

For information and instructions on building and managing segments in the Unified Segmentation environment including ad hoc analysis features, see the Unified Segmentation documentation.

- **Features**
  - Segment Definition Changes
  - What happened to my existing segments?
  - What happened to my existing segment folders?
  - Can I manage all Analytics' segments in the Segment Manager?
  - What is a Hit Container? Is it different from a Page View Container?
  - What rights and privileges do I need to use, create, and manage segments?
  - What should I do with duplicate segments that have the same name but may have different definitions?
  - How does Adobe recommend that I clean up segments?
  - Why can't I delete this segment?
  - More on what happens to your existing segments

**Features**

- **Segments** are universal to all report suites. Previously, segments were report-suite specific.
- The Segment Manager lets you set up workflows with segment sharing, tagging, verification, and approval features.
- The Segment Builder has been updated to simplify segment creation.
- You can tag segments to organize and search later instead of using folders. Previously, you used folders (in ad hoc analysis) to organize your segments.
- You can create Sequential Segments outside of Ad Hoc Analysis.
• **Note:** In Ad Hoc Analysis, you cannot add date ranges to segments. This feature is available in Analysis Workspace. You can also not use Only Before/Only After sequencing in Ad Hoc Analysis.

**What happened to my existing segments?**

Your existing segments will continue to work as they did before the introduction of Analytics Segmentation. Any reports that have these segments applied will continue to work correctly.

Most former pre-defined and suite segments will be migrated over as segment templates into the segment builder. Segment templates are used to quickly build custom segments with common audiences. Segment templates can't be applied to a report directly, but they can be easily saved to a custom segment.

**What happened to my existing segment folders?**

Instead of (Ad Hoc Analysis) folders, the Segment Manager uses tags. Your folder names are automatically converted to tags and those tags are applied to the respective segments.

**Can I manage all Analytics segments in the Segment Manager?**

Within the Ad Hoc Analysis Segment Manager, you can only see the segments that belong to you (the segments you created) and the segments that are specifically shared with you.

**What is a Hit Container? Is it different from a Page View Container?**

The Page View container was renamed to the Hit container to indicate that this container segments all types of data and not just page views. For example, link tracking calls, and `trackAction` calls from the mobile SDKs are all included or excluded by the hit container.

Note that there wasn't a change to the way this container functions, it was simply renamed.

**What rights and privileges do I need to use, create, and manage segments?**

All users can create and edit personal segments. These segments can be shared directly with any other Analytics user.

Admins can edit any segment, and share segments with groups and set rights to access segments for the organization.

**What should I do with duplicate segments that have the same name but may have different definitions?**

Since segments work in multiple report suites, you might find that you have multiple segments with the same name. We recommend that you either

• Rename segments that have the same name, but different definitions, or
• Delete segments that are no longer necessary.

**How does Adobe recommend that I clean up segments?**

• Tag all segments with legacy tag.
• Review the segments that you have.
• Add them to the segment library where applicable.
• Approve segments that are canonical.
• Tag segments according to best practices.
Why can’t I delete this segment?

If the segment was *published to the Marketing Cloud*, you cannot delete it or edit it. However, you can copy it and edit the copied version.

More on what happens to your existing segments

<table>
<thead>
<tr>
<th>Segment Category</th>
<th>What happens to these segments?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Favorites Segments (Ad Hoc Analysis)</td>
<td>These Ad Hoc Analysis segments are displayed as regular segments in Adobe Analytics.</td>
</tr>
<tr>
<td></td>
<td>They should not be confused with the Favorites feature in the Segment Manager that lets you mark segments as favorites.</td>
</tr>
<tr>
<td>Pre-Configured Segments:</td>
<td>These segments will be migrated over as <em>segment templates</em> into the segment builder.</td>
</tr>
<tr>
<td>• Single Page Visits</td>
<td>Existing reports that have these segments applied will continue to work correctly.</td>
</tr>
<tr>
<td>• Visits from Mobile Devices</td>
<td></td>
</tr>
<tr>
<td>• Visits from Natural Search</td>
<td></td>
</tr>
<tr>
<td>• Visits from Paid Search</td>
<td></td>
</tr>
<tr>
<td>• Visits with Visitor ID Cookie</td>
<td></td>
</tr>
<tr>
<td>Marketing Cloud (Suite) segments:</td>
<td>Most of these segments (except the ones marked with an asterisk *) will be migrated over as <em>segment templates</em> into the segment builder. Additionally, several new segment templates have been added.</td>
</tr>
<tr>
<td>• Non-Purchasers</td>
<td>Existing reports that have these segments applied will continue to work correctly.</td>
</tr>
<tr>
<td>• Purchasers</td>
<td></td>
</tr>
<tr>
<td>• First Time Visits</td>
<td></td>
</tr>
<tr>
<td>• Visits from Social Sites</td>
<td></td>
</tr>
<tr>
<td>• Visits of More than 10 Minutes*</td>
<td></td>
</tr>
<tr>
<td>• Visits with 5+ Previous Visits*</td>
<td></td>
</tr>
<tr>
<td>• Visits from Facebook*</td>
<td></td>
</tr>
<tr>
<td>Admin segments (also known as &quot;Global&quot; segments)</td>
<td><em>Admin</em> segments will be migrated into the new segment interface and will show up as segments shared with everyone.</td>
</tr>
<tr>
<td></td>
<td>The owner of these segments is set to the admin with the oldest account in the login company’s list of admin users, however, all Admins can delete, edit and share these segments.</td>
</tr>
<tr>
<td></td>
<td>The segment management interface in the Admin Console where Admins created and managed these global segments is no longer available. Admins should now use the new segment builder to create segments and share them with appropriate groups or individuals or with everyone.</td>
</tr>
</tbody>
</table>
Settings

Configure global behavioral settings. For example, you can configure Autosave, chart and table settings, and specify the font and locale.

Click **Tools > Settings** to access **Global Settings**.

**General Settings Tab - Definitions**

Configure behavioral settings for data sources, project saving, charts, and tables.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Settings</td>
<td><strong>Count Repeat Instances</strong>: Specifies whether instances are counted in reports. Meaning, if you have multiple sequential values for the same variable you can count them either as one or multiple instances of the variable.</td>
</tr>
<tr>
<td></td>
<td>For example, you might see repeat page reloads, which are the number of times that pages on your website are reloaded or refreshed during a single visit. This option lets you specify whether multiple hits on the same page are counted as one, or as multiple page views.</td>
</tr>
<tr>
<td></td>
<td><strong>Ad Hoc</strong>: Specifies Ad Hoc as the only source of data for reporting. This data comes from image requests generated by web pages.</td>
</tr>
<tr>
<td></td>
<td><strong>Data Sources</strong>: Specifies whether to use data uploaded from other Adobe sources or custom data sources. This data becomes available to products in the Marketing Cloud. See <a href="#">Data Sources</a> for more information.</td>
</tr>
<tr>
<td></td>
<td><strong>Both</strong>: (Default) Uses data from ad hoc analysis and other data sources.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Changing these options can result in reporting discrepancies between ad hoc analysis data and the marketing reports and analytics data.</td>
</tr>
<tr>
<td>Autosave Settings</td>
<td><strong>Autosave Enabled</strong>: Enables autosave functionality.</td>
</tr>
<tr>
<td></td>
<td><strong>Autosave Project Frequency</strong>: Lets you adjust the time increments of the autosave feature. A project autosave is created only on an ad hoc crash.</td>
</tr>
<tr>
<td>Chart Settings</td>
<td><strong>Collapse charts by default</strong>: Click this button to display reports without a chart in the top section. Once a report is displayed with this option you can extend it manually.</td>
</tr>
</tbody>
</table>
### Table Settings

Configure how you want to display cell data in tables, and bar graphs in charts.

**Definition Field**

- **Show Line Numbers**: Turns on or off line numbering in the report table.

### Ranked Tab - Definitions

Configure how data displays in columns, and select default metrics for traffic and conversion reports.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Settings</td>
<td>Configure how you want to display cell data in tables, and bar graphs in charts.</td>
</tr>
<tr>
<td>Select Default Metrics</td>
<td>Select default metrics for Traffic and Conversion reports, in addition to the metrics available for all reports.</td>
</tr>
<tr>
<td></td>
<td><strong>Include Report Specific Default</strong>: Specifies whether to include default metrics when customizing the view.</td>
</tr>
</tbody>
</table>

### Site Analysis Tab - Definitions

Configure how metrics and other graphical settings for the Site Analysis report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metrics</td>
<td>Select the metrics represented by cylinder width and cylinder height. Determine which metric is displayed using color, and determine the colors that represent low value and high value for that metric. You can establish the metrics for the X and Y axis, and add any other metrics you want in to appear in the report's pop-up text. You can also invert any of the selected metrics for the display.</td>
</tr>
<tr>
<td>General and Alerts</td>
<td>Enable and disable certain graphical elements of the report. You can configure alerts that display in the report when metrics associated with the pages represented by cylinders pass a specific value.</td>
</tr>
</tbody>
</table>
Font and Locale Tab - Definitions

Specify the regional settings for language, as well as the default font. You must restart for font and locale changes to take effect.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a locale</td>
<td>Lets you specify the language to display in the user interface.</td>
</tr>
<tr>
<td>Select a font</td>
<td>Lets you specify a font in which to display.</td>
</tr>
</tbody>
</table>
Scheduling Manager

You can customize the delivery schedule for reports. You can stop the delivery at a certain time, or specify the number of times you want to send a report. New schedules use the date range defined in the report. For example, if you create a report for the last 90 days and schedule it to run daily, you receive a report for the last 90 days each day. If you create a report with a static date range from the calendar, you’ll see the same report each time it is sent.

💡 **Note:** When a user account is disabled, any scheduled report deliveries created by that user are suspended.

To ensure that line items in a breakdown are persistent in saved and scheduled reports, use the **Edit Items** feature in the **Table Builder** to create fixed dimension lists in breakdowns.

⚠️ **Important:** Ad Hoc Analysis lets you quickly define and schedule reports for specific, timely, ad hoc reporting needs. It is not designed for full exports of data with a massive number or rows, columns, metric evaluations, or extensive breakdowns using data extracts.

Practical constraints for scheduled reporting in Ad Hoc Analysis are based on this principle: If your report doesn't build within ten minutes (the timeout for Ad Hoc Analysis), then your report is most likely too complex.

Most likely your report has too many metrics, too many dimension element breakdowns, too many rows or columns, or other extremes that make it too long a report generation process for Ad Hoc Analysis. This type of report needs to be run in Data Warehouse, an Adobe Analytics capability made for full data extraction running offline with report generation that can take many hours or days.

For example, Ad Hoc Analysis can handle 50,000 rows of data, but breaking down that data for ten browser types means 50,000 times 10, an exponential increase that may be too complex for an ad hoc reporting tool. Additional breakdowns again increase the rows of data exponentially. Defining the actual number or rows, columns, and breakdowns to constrain for Ad Hoc Analysis reporting cannot be defined in stark terms but is a combination of all these factors.

Schedule a report for delivery

Steps that describe how to schedule a report for delivery.

1. Click **Tools**, then click **Schedule Manager**.
2. On the **Schedule Manager**, click **New**.

Delivery Options - Definitions

Definitions for the settings on Delivery Options.

You can send your information as displayed in the currently selected report to the format you select. You can send it one time or set up a delivery schedule, and specify the file format you prefer. You can create and send a digital signature to assure the receiver of the file that it is authentic. You can send the file to an email address or upload it to an FTP server.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The configurable name of this report.</td>
</tr>
</tbody>
</table>
### Field | Definition
---|---
ID | Tells you the report ID.

### File Format
- **Excel**: Outputs your report in a spreadsheet, including all images. Editable in Microsoft Excel.
- **CSV**: Outputs your report in Comma Separated Values. Editable in a simple text editor (such as Notepad) or a spreadsheet editor (such as Excel). Does not contain any images.
- **PDF**: Outputs your report in Portable Document Format. Non-editable and viewable in Adobe Acrobat or Adobe Reader.
- **HTML**: Outputs your report in a Hypertext Markup Language attachment. This format is what most websites are composed of. Not editable unless you are familiar with HTML code.
- **Word**: Outputs your report in Rich Text Format, including all images. Editable in Microsoft Word or WordPad.

### Advanced
- **Advanced Format Settings - Definitions**

### File Destination
- **Email**: Settings to send via email.
- **FTP**: Settings for uploading to an FTP server.

### Report Range and Delivery Schedule
- **Specifications when to deliver the report. New schedules use the date range defined in the report. For example, if you create a report for the last 90 days and schedule it to run daily, you receive a report for the last 90 days each day. If you create a report with a static date range from the calendar, you'll see the same report each time it is sent.**

### Advanced Format Settings - Definitions
Definitions for the settings on Advanced Format Settings.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filename</td>
<td>A user defined file name.</td>
</tr>
<tr>
<td>Append ID to filename</td>
<td>Automatically appends the report ID to the file name.</td>
</tr>
<tr>
<td>Append date to filename</td>
<td>Automatically appends the date of the report to the file name.</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Language</td>
<td>Lets you select a language for the report. You can send the report in any of the following languages regardless of the language that you use.</td>
</tr>
<tr>
<td></td>
<td>• English</td>
</tr>
<tr>
<td></td>
<td>• Spanish</td>
</tr>
<tr>
<td></td>
<td>• Simplified Chinese</td>
</tr>
<tr>
<td></td>
<td>• Traditional Chinese</td>
</tr>
<tr>
<td></td>
<td>• French</td>
</tr>
<tr>
<td></td>
<td>• German</td>
</tr>
<tr>
<td></td>
<td>• Japanese</td>
</tr>
<tr>
<td></td>
<td>• Portuguese</td>
</tr>
<tr>
<td>Encoding</td>
<td>Specifies an encoding type.</td>
</tr>
<tr>
<td>Send Report as a Compressed File</td>
<td>Compresses the file.</td>
</tr>
<tr>
<td>Send Digital Signature File</td>
<td>Creates a digital signature to send with the email.</td>
</tr>
</tbody>
</table>
Table Builder

Use the Table Builder to create a report with any configuration of metrics, dimensions, and segments. For example, you can add multiple metrics to the Table Builder, then apply segment to all of them at once. You can apply items from the tool panes as rows and breakdowns, or as columns, and easily pivot the table for a different view. After building the table, you can interact directly with the resulting data table for further analysis. Keep in mind that generating a data table from the Table Builder runs a query and creates a new data table.

The **Table Builder** is not available for certain pathing reports like **Site Analysis**, **Fallout**, **Flow** and **Virtual Focus**.

### Table Builder Descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Rows / Breakdowns**    | Creates rows and breakdowns from added items. The first item you drag to **Rows / Breakdowns** becomes the left column in the data table, or the parent item in a breakdown. Adding subsequent items creates breakdowns. For example, if you add Page and then Cities dimensions, the report breaks down the page by cities. You configure how many rows and breakdowns to show for each item, using the following menus:  
  • **Show** and **Breakdown**: Lets you specify the number of items and breakdowns to display.  
  • **Default**: Uses the settings configured in **Breakdown Properties**. You can also configure a fixed value list to, for example, break down one metric by multiple metrics. |
<p>| <strong>Breakdown Properties</strong> | Lets you specify default settings for how many rows and breakdowns you want displayed, based on the order in which you add items. You can specify how many total results per page to display, and how many of those rows to break down. Settings you make in the <strong>Table Builder</strong> override the default settings in the <strong>Breakdown Properties</strong>. |
| <strong>Edit Items</strong>           | Choose a list of dimension items to create a fixed list for breakdowns. When you add items to this list, they become persistent in a saved report and will not be collapsed when you open a saved or scheduled report. See <strong>Break Down Table Data</strong>. |
| <strong>Columns</strong>              | Lets you build columns with items from dimensions, segments, and metrics. You can also pivot the columns using the arrow icon, which pivots the X and Y axes. <strong>Show</strong>: Lets you limit the number of columns generated in the data table. |</p>
<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Summary</strong></td>
<td>Shows the report’s structural layout so that you know how many rows and columns will be created. The summary reflects the configuration specified in the <strong>Rows / Breakdowns</strong> and <strong>Columns</strong> groups.</td>
</tr>
</tbody>
</table>
| **Replace Table** | Builds (and overrides) the existing table, based on your **Table Builder** configuration.  
  
  **Note:** Clicking **Replace Table** reruns the report and overrides the data in the table grid. If you add items to the table grid, the correlation between the table and the **Table Builder** is no longer valid. |
| **Warning**     | Indicates that the **Table Builder**’s configuration will not return data, or that no metrics are selected.                                  |

**Generate a report from the Table Builder**

Steps that describe how to use the **Table Builder**.

1. To access the **Table Builder**, run a supported report, then click **Table Builder**.
2. Drag items (dimensions, metrics, segments) from the tool panes to the **Table Builder**.
3. Configure the items as rows, breakdowns, and columns.
4. Click **Replace Table** to generate the report.

  Clicking **Replace Table** runs a new query and creates a new data table. Manual edits to the detail table are not reflected in the Table Builder.
Time

Time is a reporting dimension useful for trending over hours, days, weeks, and date ranges. For example, a Products Report displays how much revenue a product made during the selected date range. You can add a Day dimension to see the trend across each day of the reporting period. Time provides granularity settings of Hour, Day, Week, Month, Quarter, and Year. Date range presets include settings such as Today, Yesterday, and Last 7 Days.

To add Time dimensions, drag one or multiple date ranges from the Time tool pane to the report table or the Table Builder.

This example shows a trended Day dimension with revenue.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Ranges</td>
<td>Lets you select one or more time periods and drag them to the Table Builder or report grid. View time periods as breakdowns in rows, or as column headers. You can select periods like day, week, month, or custom date ranges. If you use a Custom Calendar in SiteCatalyst, your report suites inherit those settings.</td>
</tr>
<tr>
<td>Trending</td>
<td>Lets you trend reporting over hour, day, week, month, and so on. When you drag items from Trending to the report, you are viewing data over a time setting that is governed by the specified date range from the calendar.</td>
</tr>
</tbody>
</table>
Ad Hoc Analysis Release Notes

Fixes and new features introduced in past releases of Ad Hoc Analysis (formerly Discover).

For all Ad Hoc Analysis Release Notes, refer to the Marketing Cloud Release Notes.
Contact and Legal Information

Information to help you contact Adobe and to understand the legal issues concerning your use of this product and documentation.

Help & Technical Support

The Adobe Experience Cloud Customer Care team is here to assist you and provides a number of mechanisms by which they can be engaged:

• Check the Marketing Cloud help pages for advice, tips, and FAQs
• Ask us a quick question on Twitter @AdobeExpCare
• Log an incident in our customer portal
• Contact the Customer Care team directly
• Check availability and status of Marketing Cloud Solutions

Service, Capability & Billing

Dependent on your solution configuration, some options described in this documentation might not be available to you. As each account is unique, please refer to your contract for pricing, due dates, terms, and conditions. If you would like to add to or otherwise change your service level, or if you have questions regarding your current service, please contact your Account Manager.

Feedback

We welcome any suggestions or feedback regarding this solution. Enhancement ideas and suggestions can be added to our Customer Idea Exchange.

Legal

© 2017 Adobe Systems Incorporated. All Rights Reserved.
Published by Adobe Systems Incorporated.

Terms of Use | Privacy Center

Adobe and the Adobe logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. A trademark symbol (®, ™, etc.) denotes an Adobe trademark.

All third-party trademarks are the property of their respective owners. Updated Information/Additional Third Party Code Information available at http://www.adobe.com/go/thirdparty.